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LATEX zu benutzen ist das eine, dafür gibt es hervorragende Einführungen.
Was benötigen Sie für die Installation eines LATEX-Systems unter Windows? Was
mache ich mit MiKTEX, wozu brauche ich Ghostscript, was ist TeXmaker, und
warum schwören viele auf Emacs und vor allem wie paßt alles zusammen?

Diese Anleitung soll die Suche ersparen und zeigt Schritt für Schritt, was Sie
alles brauchen und wie Sie die einzelnen Komponenten einrichten und benutz-
ten.

Wenn Ihnen diese Anleitung hilft, gefällt Ihnen bestimmt auch mein Buch
»Wissenschaftliche Arbeiten schreiben mit LATEX«, in der 3., überarbeiteten
Auflage erschienen im mitp-Verlag, ISBN 978-3826658921.

Ich freue mich über Anregungen und Hinweise auf eventuelle Fehler. Bei Rückmeldun-
gen bitte die Versionsnummer mit angeben:
Revision: 1552 Date: 2010-08-29 20:49:46 +0200 (Sun, 29 Aug 2010)

Danke an meine aufmerksamen Leser für viele Anmerkungen und Korrekturen.
Dieses Dokument existiert sowohl in HTML als auch in PDF. Die korrekten URL lauten:

• http://schlosser.info/downloads/latexsystem.pdf für die PDF-Version und

• http://schlosser.info/latexsystem für die HTML-Seite.

Eine englische Fassung ist verfügbar unter http://schlosser.info/latexsystem-en/
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1 Intention – LATEX einrichten kann jeder

LATEX ist zwar auch ein Programm, hauptsächlich jedoch eine Art der Dokumentbeschrei-
bung. LATEX ermöglicht nicht nur, wissenschaftliche Arbeiten zu verfassen, sondern auch
hervorragende Briefe, Präsentationen und vieles mehr.

Diejenigen, die bisher nicht mit freier Software gearbeitet haben, erscheint es anfangs
bisweilen befremdlich, selbst verschiedene Komponenten zu einem System zu integrieren,
so daß sich manche nicht so einfach hintrauen. Deswegen stelle ich hier meine Umgebung
vor, mit der ich aus LATEX sowohl Postscript und PDF als auch HTML erzeuge.

Dies ist keine Einführung in LATEX. Dafür gibt es bereits hervorragende Angebote sowohl
im Netz als auch in Buchform. Zum Einstieg bis zum kompletten Ergebnis eignet sich
mein Buch1. Empfehlenswert ist auch die De-TeX-FAQ2, zu beziehen vom Dante-Server3,
außerdem l2tabu, das veraltete Befehle und Pakete und ihre Alternativen aufzeigt. Lesen
Sie außerdem die Dokumentation von KOMA-Skript, einer in Europa verbreiteten Makro-
bibliothek, die darüber hinaus Antworten auf viele typografische Fragen bereit hält. Zu
finden in jeder besseren LATEX-Distribution unter <texmf>/doc/latex/koma-script/.

Wer mit der Installation trotz der Anleitung nicht zurecht kommt oder eine sonstige Fra-
ge zum Thema LATEX hat, der schreibe nicht gleich mir persönlich, sondern suche zunächst
im Web und in der FAQ und wende sich bei anhaltender Unklarheit an die Newsgruppe
de.comp.text.tex. Dort können die meisten Fragen beantwortet werden; und auch zum The-
ma Installation unter Windows antworte ich dort viel lieber als per Mail, weil zum einen
die Antworten dann allen zur Verfügung stehen und außerdem dort viele kompetentere
Anwender und Entwickler mitlesen.

Diese Anleitung ist anwendbar für Windows XP, Vista und Windows 7.
Letzte wichtige Anmerkung: Diese Anleitung ersetzt nicht die Originaldokumentationen

der einzelnen Programme und Bausteine4. Bei Fehlern tun Sie gut daran, die Dokumentati-

1Schlosser, Joachim: Wissenschaftliche Arbeiten schreiben mit LaTeX. 3. Auflage. mitp Verlag, Oktober 2009,
ISBN 978–3826658921.

2Raichle, Bernd/Niepraschk, Rolf/Hafner, Thomas: Fragen und Antworten (FAQ) über das Textsatzsystem
TEX und DANTE, Deutschsprachige Anwendervereinigung TEX e.V. DANTE e.V. http://www.dante.de/
faq/de-tex-faq/.

3Dante: Deutschsprachige Anwendervereinigung TeX e. V.
4Siehe dazu auch meinen Beitrag in de.comp.text.tex
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2 Was brauchen Sie überhaupt?

on des jeweiligen Programms zur Hilfe zu nehmen. Die Anleitung bezieht sich ausschließ-
lich auf die hier angegebenen Programme. So sind z. B. die Abschnitte über Emacs und
Aufsätze nicht ohne weiteres auf XEmacs übertragbar. Neuere Versionen der Programme
stellen in der Regel kein Problem dar (ohne Gewähr).

2 Was brauchen Sie überhaupt?

Um vernünftig arbeiten zu können, benötigen Sie neben der eigentlichen TEX Distribution
verschiedene Komponenten.

LATEX Distribution: MiKTEX Die LATEX-Distribution ist der Kern des Systems. Sie beinhaltet
die wichtigsten Programme, die zum Erzeugen von DVI, Postscript und PDF notwendig
sind, außerdem alle Zusatzpakete, die erweiterte Möglichkeiten wie z. B. Musiksatz, Stan-
dardlayouts für verschiedene Organisationen, Layoutbesonderheiten u. ä. bieten.

Ich verwende MiKTEX 2.8. Diese Distribution ist meines Erachtens nach sehr einfach zu
installieren, funktioniert prächtig und wird gut gepflegt. Je nach gewünschtem Umfang
sind 90 bis 920 MB herunterzuladen. Alternativ können Sie auch eine unregelmäßig aktua-
lisierte CD-ROM des Systems bestellen, oder Sie kaufen sich mein Buch Schlosser, Joachim:
Wissenschaftliche Arbeiten schreiben mit LaTeX. 3. Auflage. mitp Verlag, Oktober 2009,
ISBN 978–3826658921, in dem ebenfalls eine CD-ROM mit MiKTEX enthalten ist.

Die Distribution ist nur dafür verantwortlich, aus dem Eingabetext das fertige Doku-
ment zu generieren. Im Editor schreiben Sie ihren Text.

Editor: Texmaker Damit der LATEX-Einstieg nicht zu schwer fällt, empfehle ich abwei-
chend von meiner Konfiguration TEXMAKER als Editor.

Auf die Installation des ebenfalls sehr beliebten TEXLIPSE, einem Plugin für ECLIPSE,
gehe ich nicht ein. Jeder, der ohnehin schon Eclipse nutzt, weiß, wie man Pakete nachin-
stalliert.

TEXMAKER ist für mausorientierte Benutzer ideal. Er bietet neben grafischen Menüs für
die meisten mathematischen Symbole und anderen wichtigen Befehle auch während des
Tippens von Befehlen mögliche Vervollständigungen als sogenannte »Tooltips«. Gerade
für den Neuling ohne EMACS-Erfahrung eignet sich TEXMAKER. Später können Sie dann
auf das Profigerät EMACS umsteigen.

Natürlich läßt TEXMAKER einiges missen, das bei EMACS vorhanden ist, wie z. B. eine
Numerierung in der Gliederungsansicht oder eine leistungsfähige Behandlung von Mar-
ken (Labels) und Literaturzitaten. Auch die integrierte Rechtschreibprüfung hat noch nicht
die Qualität, wie sie ISPELL/ASPELL für EMACS bieten.

Editor: Emacs + RefTeX + AUCTeX + Ispell Wer unter Unix bereits mit LATEX gearbeitet
hat, benutzt eventuell den EMACS, eines der mächtigsten GNU Programme.

Ich habe mich wegen der Aufsätze AUCTEX und REFTEX für EMACS entschieden.
AUCTEX bietet für alle häufig benutzten Konstrukte aus LATEX Tastaturkürzel an, die das
Arbeiten erheblich beschleunigen. Zudem bietet AUCTEX eine Voransicht von Grafiken,
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2 Was brauchen Sie überhaupt?

Tabellen und Formeln direkt im Editor. Somit wird das Beste aus den beiden Welten WYSI-
WYG und Offlinebearbeitung vereint5 REFTEX läßt Sie beim Einfügen von Querverweisen
aus einer Liste aller verfügbaren auswählen und hilft beim Erstellen der entsprechenden
Marken. Auch das Einfügen von Literaturzitaten geht mit REFTEX schnell und einfach.

Lesen Sie die Einführungen zu EMACS und AUCTEX und holen Sie sich die EMACS

Referenzkarte von www.refcards.com. Der anfängliche Lernaufwand lohnt sich, wird er
doch bald mehr als aufgewogen durch ein schnelles, effizientes Arbeiten.

Auch eine Rechtschreibprüfung haben Sie in EMACS dabei. Sie heißt ISPELL und ist
hervorragend in den Editor integriert. Eine für Windows portierte Version, die ich zur
einfacheren Verwendung mit einer Installationsroutine versehen habe, stelle ich auf mei-
ner Homepage6 zur Verfügung. Sie enthält Wörterbücher für Englisch und Deutsch. Wei-
tere Wörterbücher, z. B. für die neue deutsche Rechtschreibung, Französisch, Italienisch,
u. v. m., finden sich im Netz.

Grafiken in Postscript mit Ghostscript Postscript ist in der Unix-Welt das Austausch-
format für Vektorgrafiken. So ist es auch unter LATEX am besten, Grafiken als (Encapsulated)
Postscript (PS/EPS) einzubinden.

Aus allen Windowsanwendungen mit ihren Dateiformaten wie z. B. existierende Word-
oder PowerPoint-Zeichnungen, Bitmaps oder Vektorformaten wie Visio läßt sich Postscript
erzeugen, selbst wenn die jeweilige Anwendung dies nicht direkt unterstützt. Möglich
wird dies durch Drucken in eine Datei über einen Postscript Druckertreiber.

Um später vorliegende Postscriptdateien anzusehen und kleinere Veränderungen vor-
zunehmen, benötigen Sie GHOSTSCRIPT mit seinem grafischen Frontend GSVIEW.

HTML-Konvertierung: TeX4ht TEX4HT hat den Vorteil, daß es als Paket in der Distribu-
tion MIKTEX enthalten ist7. Wer die allerneueste Version haben möchte, kann sich diese
nachinstallieren.

TEX4HT, egal ob mitgelieferte oder selbstinstallierte Version, benötigt zur Grafikkonver-
tierung das Programm IMAGEMAGICK.

Übersicht und Lizenzierung Die angegebenen Paketgrößen beziehen sich auf das Dow-
nloadvolumen, nicht auf den für die Installation benötigten Platz.

5Kastrup, David: Revisiting WYSIWYG paradigms for authoring LaTeX. TUGboat, 23 November 2002, Nr. 1.
6http://schlosser.info/ispell-windows-emacs/
7Zur Benutzung siehe die Dokumentation in <texmf>/doc/html/tex4ht.
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3 Installation und Konfiguration

Programm Größe MB Quelle

MiKTEX 90–920 MB http://www.miktex.org
Texmaker 6 MB http://www.xm1math.net/texmaker/
GNU Emacs 39 MB http://www.gnu.org/software/emacs/
AUCTeX 2 MB http://www.gnu.org/software/auctex/
Ispell Win32 1,5 MB http://schlosser.info/ispell-windows-emacs/
Ghostscript 10 MB http://ghostscript.com/releases/
GSview 1,5 MB http://pages.cs.wisc.edu/~ghost/gsview/
TeX4ht 1,5 MB http://www.cse.ohio-state.edu/~gurari/TeX4ht/mn.html
ImageMagick 10 MB http://www.imagemagick.org

Σ ca. 1 · 103 MB

Alle in dieser Anleitung genannten Programme und Pakete sind mindestens kostenlos,
meist sogar freie Software8. Die Lizenzen sagen allesamt aus, daß die Verbreitung frei-
gestellt ist. Die meisten erlauben zudem die Veränderung des Quellcodes, einige wenige
verbieten wiederum den kommerziellen Verkauf.

Trotz der prinzipiellen Kostenfreiheit sind Sie eingeladen, sich bei den einzelnen Pro-
jekten bei Gefallen auch finanziell erkenntlich zu zeigen. Siehe dazu die Webseiten der
Projekte.

3 Installation und Konfiguration

Mein System läuft auf Windows 7. Einige Zugriffspfade zu bestimmten Systemeinstellun-
gen können auf Ihrem System geringfügig von den beschriebenen abweichen.

Zugriffspfade bezeichnen Startmenüeinträge, Schaltflächen und Menüeinträge mit den
entsprechenden Namen.

Die Reihenfolge der einzelnen Schritte ist wegen Programmabhängigkeiten unbedingt
einzuhalten. Diese Anleitung ist selbstkonsistent, d. h. alle Verzeichnisse passen zusam-
men. Verwenden Sie ein anderes Verzeichnis für ein Programm, müssen Sie dies in nach-
folgenden Schritten berücksichtigen.

3.1 MiKTEX herunterladen und installieren

Laden Sie sich zunächst von http://www.miktex.org den Webinstaller und rufen diesen
auf. Nun müssen Sie entscheiden, ob Sie die Variante Basic oder Complete möchten. Wenn
Sie breitbandig ans Internet angeschlossen sind, holen Sie sich am besten Complete, an-
sonsten eben die kleinere Fassung. Einzelne Pakete werden hier problemlos automatisch
nachgeladen.

Die Installation selbst ist sehr simpel: Einfach so lange auf weiter klicken, bis Sie fertig
sind und allen Vorgaben folgen. Da der Installer zwischen 90 und 920 Megabyte aus dem

8Was bekanntlich ein Unterschied zu kostenlos ist: »Free as free speech, not free beer.« Siehe dazu die Seiten
der Free Software Foundation unter http://www.fsf.org.
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3 Installation und Konfiguration

Internet herunterlädt, führen Sie dies bitte nur an einem schnellen Internetzugang durch
und nicht über Mobilfunk.

Alle Programme können Sie dann direkt von der Kommandozeile aufrufen.

3.2 Grafikerstellung und -konvertiertung

Den Postscript Druckertreiber richten Sie ein mit Start→ Einstellungen→ Drucker→ Neuer
Drucker. Als erstes lokaler Drucker wählen und als Anschluß den FILE-Port, der richtige Trei-
ber ist der Apple Color LaserWriter 12/600 (bis Windows Vista), bzw. der MS Publisher Color
Printer (ab Windows 7, in der Herstellerliste »generic«). Den Druckernamen auf »Postscript
File« setzen.

Nach der Installation unter Start→ Einstellungen→ Drucker→ Postscript File→ Drucker
→Druckeinstellungen→ Erweitert→Optionen für Dokument→ Postscript-Optionen folgende
Einstellungen vornehmen: Die Felder Postscript-Ausgabeoption auf »Optimale Portabilität«
und TrueType-Downloadoption auf »Umriß« setzen. Deaktivieren Sie das ICM Color Mat-
ching, um Farbverfälschungen zu vermeiden.

Ab sofort kann jede Windowsanwendung Postscriptdateien erzeugen, indem Sie den
neuen Drucker verwenden. Die erzeugte Datei – der Sie immer die Erweiterung .ps anstatt
des vorgegebenen .prn geben sollten – können Sie nun in GSVIEW betrachten und nach
EPS wandeln.

Für die automatische Weiterverarbeitung installieren Sie GHOSTSCRIPT, zu beziehen von
http://ghostscript.com/releases/. Hier gibt es nichts zu beachten (also »Weiter/Next«
bis fertig). Da Sie vielleicht auch Postscriptdateien zur Kontrolle ansehen möchten, spie-
len Sie GSVIEW9, das grafische Frontend zu GHOSTSCRIPT ein. Hier können Sie bei der
Installation das Verzeichnis ebenfalls auf C:\Programme(x86)\Ghostscript setzen, auch als
Programmgruppe wählen Sie die gleiche wie bei GHOSTSCRIPT.

Es ist überaus sinnvoll, GHOSTSCRIPT dem Suchpfad hinzuzufügen. Also wiedereinmal
in Start → Einstellungen → Systemsteuerung → System → Erweitert → Umgebungsvariablen
der Variable PATH das jeweilige Verzeichnis, z. B. C:\Programme(x86)\Ghostscript\gs8.
54\bin, durch Semikolon abgetrennt hinzufügen. Wichtig: Keine Leerzeichen vor und nach
Einträgen in der PATH-Variable!

Um sich auf die Dauer die Arbeit zu erleichtern, empfehle ich, einen »EPS-Drucker«
einzurichten und zu verwenden, auch dafür habe ich eine kurze Anleitung im Internet
verfaßt10.

3.3 Texmaker einrichten

TEXMAKER, von http://www.xm1math.net/texmaker/ zu beziehen, ist rasch installiert: Wie
bei MIKTEX einfach alle Vorgaben des Installers akzeptieren. Beim ersten Aufruf fragt TEX-
MAKER, ob es sich für die Verwendung mit MIKTEX konfigurieren soll, dem Sie zustimmen
und alle weiteren Vorgaben wiederum akzeptieren.

9GSview. http://pages.cs.wisc.edu/~ghost/gsview/.
10Schlosser, Joachim: EPS Writer für Windows. http://schlosser.info/epswriter.
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3 Installation und Konfiguration

3.4 Emacs einrichten

Ein Mangel von Windows muß zunächst vor dem ersten Start behoben werden, nämlich die
Nichtexistenz der Umgebungsvariablen11 HOME. Dazu erstellen Sie in Start→ Einstellungen
→ Systemsteuerung→ System→ Erweitert→Umgebungsvariablen12 einen neuen Eintrag mit
Namen HOME und weisen diesem ein beliebiges Verzeichnis zu, in dem Sie alle individuel-
len Einstellungen speichern möchte13. Der Name des Verzeichnisses sollte kein Leerzeichen
enthalten!

Für alle Umgebungsvariablen gilt: Möchten Sie die Umgebungsvariablen nur für den
aktuellen Benutzer anlegen, erstellen Sie sie in Benutzervariablen. Sollen sie für alle Be-
nutzer gelten, werden sie in Systemvariablen angelegt. Wir benötigen GNU EMACS, den
wir von ftp://ftp.gnu.org/gnu/emacs/windows/emacs-23.1-bin-i386.zip herunterla-
den, sowie AUCTEX als vorkompiliertes Paket, zu beziehen von http://ftp.gnu.org/
pub/gnu/auctex/auctex-11.86-e23.1-msw.zip. Wir entpacken die EMACS-Archivdatei
emacs-2x.x-bin-i386.zip in das Programmverzeichnis aus (auch Winzip kann das), so
daß wir dann ein Verzeichnis wie z. B. C:\Programme(x86)\emacs erhalten. In eben dieses
Verzeichnis entpacken wir auch das Archiv auctex-11.xx-e2x.x-msw.zip, wobei minde-
stens eine Datei überschrieben wird. Die meisten Entpacker fragen vorher nach.

Um EMACS bequemer aufrufen zu können, rufen Sie aus dem Unterverzeichnis bin das
Installationsprogramm addpm.exe auf und bestätigen dessen Nachfrage. Dies erzeugt eine
Verknüpfung im Windows-Startmenü.

Damit ist Emacs bereits fertig installiert.

AUCTEX + RefTEX Die Integration von AUCTEX mit REFTEX muß noch separat aktiviert
werden. Dazu startet man EMACS und erzeugt in diesem die Konfigurationsdatei .emacs in
seinem HOME-Verzeichnis (UNIX-Kurzname ~) mit C-x C-f ~/.emacs RET14. Dort fügen
Sie folgende Zeilen hinzu:

(add-hook 'LaTeX-mode-hook 'turn-on-reftex)
(setq reftex-plug-into-AUCTeX t)

Dann die Datei speichern mit C-x C-s, Emacs beenden mit C-x C-c, und fertig ist die Instal-
lation. Wenn nun beim Öffnen einer .tex Datei in der Menüleiste die Einträge »Preview«,
»LaTeX« und »Ref« erscheinen, hat die Installation geklappt.

Um die Voransichten schnell und platzsparend generieren zu können, ist die zusätz-
liche Grafikbibliothek LibPNG15 zu installieren. Dazu laden Sie von http://gnuwin32.
sourceforge.net/packages/libpng.htm die Archive »Binaries« und »Dependencies« her-
unter. Aus dem Binary-Archiv mit einem Dateinamen ähnlich libpng-1.2.xx-bin.zip ex-

11Umgebungsvariablen erlauben es, programmunabhängig bestimmte Verzeichnisse oder allgemein Zeichen-
ketten festzulegen, die dann von allen Programmen gelesen werden können.

12Geht übrigens schneller mittels des Tastaturkürzels Windowstaste+Unterbrechen.
13Ich empfehle, ein entsprechendes HOME-Verzeichnis auf einer anderen Partition als C: anzulegen und die

Umgebungsvariable entsprechend zu setzen. Halten Sie Daten und Einstellungen und Programme ge-
trennt, kommen Sie im Ernstfall schneller wieder ohne Datenverlust an ein lauffähiges System.

14Das Kürzel C-x steht für die Tastenkombination Strg-x, andere Buchstaben äquivalent. Übersetzt also: Strg-
x, Strg-f, » /.emacs« eintippen, Eingabe drücken. Die Zeichen » /« bedeuten, daß die Datei im HOME-
Verzeichnis abgelegt werden soll.

15Roelofs, Greg: LibPng. http://www.libpng.org/pub/png/libpng.html.
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3 Installation und Konfiguration

trahieren Sie die zwei DLLs im Unterverzeichnis bin namens libpng3.dll und libpng12.
dll und plazieren diese in Ihr Verzeichnis C:\Programme(x86)\emacs\bin. Genauso verfah-
ren Sie auch mit dem Archiv libpng-1.2.xx-dep.zip und der darin im Unterverzeichnis
bin enthaltenen DLL zlib1.dll, auch diese muß in das bin-Verzeichnis von EMACS.

Wenn Sie nun im PDF-Modus sind (C-c C-t C-p), können Sie nun Preview-LATEX mittels
C-c C-p C-d aufrufen.

Ispell ISPELL können Sie mit Hilfe meiner Distribution16 sehr einfach installieren. Das
vorgegebene Verzeichnis können Sie getrost übernehmen. Auch wird das Programm selb-
ständig zum Suchpfad hinzugefügt. Achtung: die Umgebungsvariable HOME muß bereits
existieren.

3.5 Dateitypen einrichten

Zur weiteren Vereinfachung erstellen wir einen neuen Dateityp. Zunächst benötigen wir
eine kleine Erweiterung für EMACS, welche es uns erlaubt, weitere Dateien in einem be-
reits laufenden EMACS Fenster zu öffnen. Die Erweiterung heißt EMACSSERV und ist bei
EMACS bereits dabei.

Um die Funktionalität zu aktivieren, fügen Sie der Konfigurationsdatei .emacs am An-
fang folgende Zeile hinzu:

(server-start)

Nun legen wir einen neuen Dateityp an. Dazu öffnen Sie eine Kommandozeile und ge-
ben folgenden Befehl ein17:

ftype Emacs.Document=C:\Programme (x86)\emacs\bin\emacsclient.exe -n
-a C:\Programme (x86)\emacs\bin\runemacs.exe "%1"

Sodann können wir diesem Dateityp mehrere Dateiendungen zuweisen. Wir tun dies
für .tex und .ltx mit den Befehlen

assoc .tex=Emacs.Document
assoc .ltx=Emacs.Document

Ab dann führt ein Doppelklick auf eine .tex-Datei zum Aufruf von EMACS, weitere
Dateien werden im selben Programmfenster geöffnet.

TEXMAKER kann diese Einstellung übrigens auch selbst vornehmen, Sie werden auto-
matisch beim ersten Starten des Programms danach gefragt.

Das assoc-Kommando führe ich zusätzlich auch noch für die Dateinamenserweiterun-
gen .sty, .cls, .lco und .bib aus.

Damit ist EMACS komplett installiert und die Arbeit mit dem leistungsfähigsten Editor
für LATEX kann beginnen.

16Schlosser, Joachim: Ispell compiled for Windows. http://schlosser.info/ispell-windows-emacs/.
17Ich weiß wohl, dass ein Aufruf von emacsclientw.exe das Kommandozeilenfenster unterdrückte. Leider

erscheint durch einen Bug in der Semaphoreanlage zu einer Fehlermeldung beim ersten Aufruf. Dies ist
zwar auch beim Kommandozeilenaufruf der Fall, stört aber dort sie nicht, weil sie nicht bestätigt werden
muß.
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3 Installation und Konfiguration

Dies waren die letzten Schritte, um ein System für das Erzeugen von druckfertigen Do-
kumenten im PDF oder Postscriptformat zu konfigurieren. Wer also kein HTML erzeugen
möchte, der ist hier fertig.

3.6 Neues TeX4ht installieren

TEX4HT ist bei MIKTEX dabei, und wenn Sie die vollständige Installation wählen, auch
bereits fertig zum Benutzen auf der Platte. Sollten Sie jedoch in der Änderungshistorie von
TEX4HT http://www.cse.ohio-state.edu/~gurari/TeX4ht/bugfixes.html18 Neuerungen
entdecken, die Sie unbedingt schon einsetzen wollen, bevor sie auch in MIKTEX erschei-
nen, laden Sie sich von der Homepage das aktualisierte Paket herunter.

Voraussetzung für TEX4HT ist zum einen GHOSTSCRIPT, das bereits im vorigen Ab-
schnitt installiert wurde, sowie IMAGEMAGICK, das wie folgt eingerichtet wird:

Von der IMAGEMAGICK-Website unter Downloads19 das entsprechende Windows-Exe-
cutable herunterladen und installieren. Am einfachsten alles bestätigen, was voreingestellt
ist. Dann ist nämlich das Konvertierungsprogramm bereits in den Suchpfad eingetragen.

Zur Sicherheit sollten zunächst die MIKTEX-Pakete für TEX4HT entfernt werden. Dazu
rufen Sie den MikTeX-Paketmanager auf (mpm.exe) und deinstallieren die Pakete tex4ht
und miktex-tex4ht-bin. Einfach auswählen und das Minus anklicken.

Jetzt können Sie daran gehen, das eigentliche TEX4HT zu installieren. Dazu laden
Sie von der TEX4T-Bugfixes-Seite http://www.cse.ohio-state.edu/~gurari/TeX4ht/
bugfixes.html20 das neueste Paket herunter, das einen Namen wie etwa tex4ht-x.y.
jjjj_mm_dd_hhss.tar.gz trägt und entpacken es nach C:\. Normalerweise sollte jedes
neuere Packprogramm .tar.gz entpacken können. Nun befindet sich in C:\ ein Verzeich-
nis mit einem Namen wie tex4ht-x.y.jjjj_mm_dd_hhss. Dieses Verzeichnis benennen Sie
um in tex4ht.

Sodann verschieben Sie alles, was im Verzeichnis C:\tex4ht\texmf\tex liegt, nach c:
\localtexmf\tex. Eventuell müssen Sie dieses Zielverzeichnis auch erst anlegen.

Um nun die neuen Dateien dem TEX-System bekannt zu machen, öffnen Sie eine Kom-
mandozeile (Start→ Ausführen→ “cmd”) und rufen

initexmf -u

auf.
Dann müssen die ausführbaren Dateien dem Suchpfad hinzugefügt werden. Wie schon

öfters an anderer Stelle ist dazu ein Eintrag in der Umgebungsvariablen PATH zu tätigen.
Also wiedereinmal in Start → Einstellungen → Systemsteuerung → System → Erweitert →
Umgebungsvariablen in der Variable PATH das Verzeichnis C:\tex4ht\bin\win32; vor den
Eintrag für c:\texmf\miktex\bin einfügen, notfalls auch ganz an den Anfang.

Als letztes ist die Konfigurationsdatei von TEX4HT anzupassen. Dazu öffnen Sie die
Datei c:\tex4ht\texmf\tex4ht\base\win32\tex4ht.env, suchen die Zeile

tc:\path\tfm!

18Ganz am Ende der Link »Log of modifications«
19ImageMagick Windows Binaries. http://imagemagick.org/script/binary-releases.php#windows.
20Neben der regulären TEX4HT-Distribution gibt es auch ein Paket mit einer für MIKTEX angepaßten Version.

Mit dieser habe ich keine Erfahrung, halte sie auch für überflüssig.
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und ersetzen sie durch folgende21:

tc:\Progra~1\MikTeX~1.8\fonts\tfm!

TEX4HT ist nun installiert und kann benutzt werden. Wollen Sie den OPENOFFICE.ORG-
Export von TEX4HT nutzen, muß ein Zip-Packer im System verfügbar sein. Ich verwende
dafür INFO-ZIP22, wobei ich nur die Datei zip.exe in ein Verzeichnis kopiere, welches
ohnehin bereits im Suchpfad enthalten ist. Wird bei der ersten Benutzung von oolatex.bat
festgestellt, daß die erzeugte OPENOFFICE.ORG-Datei fehlerhaft ist, kann dies in der Regel
behoben werden, indem abermals die Datei c:\tex4ht\texmf\tex4ht\base\win32\tex4ht.
env editiert wird und die Marken <oo-alt> und </oo-alt> durch <oo> bzw. </oo> ersetzt
werden und umgekehrt, womit eine alternative Bearbeitung aktiviert wird.

4 Und nun? Benutzung

Herzlichen Glückwunsch! Auch TEX4HT ist nun installiert und das TEX-System kann alle
wichtigen Ausgaben erzeugen.

Wenn Ihnen diese Anleitung geholfen hat, gefällt Ihnen bestimmt auch mein Buch
»Wissenschaftliche Arbeiten schreiben mit LATEX«, in der 3., überarbeiteten Auflage er-
schienen im mitp-Verlag.

Wie sieht es mit einem Export nach Word aus? Es gibt im Prinzip keinen Grund, LATEX
nach Word zu exportieren, trotzdem existieren Programme, die LATEX nach Rich Text For-
mat (.rtf) konvertieren, welches sich dann problemlos in Word öffnen läßt. Als besten
Weg empfinde ich jedoch den Weg über HTML oder OPENOFFICE.ORG. Heißt: LATEX mit-
tels TEX4HT nach HTML oder OPENOFFICE.ORG konvertieren, und dies dann in Word
bzw. OPENOFFICE.ORG öffnen.

Viele Ausgaben können Sie im Editor anstoßen, dafür gibt es entsprechende Knöpfe
und/oder Tastaturkommandos.

Für die Benutzung der EMACS-Zusätze sei auf deren Dokumentationen verwiesen. Mag
der Einstieg auch hart erscheinen, es lohnt sich wirklich.

Benutzung von TeX4ht TEX4HT ist ein flexibles Werkzeug, wenn es darum geht, LATEX
nach HTML zu konvertieren, jedoch verliert man bei den vielen Optionen anfangs leicht
den Überblick. Mit ein wenig Übung läßt sich jedoch auch hier alles erreichen, was man
sich vorstellt.

Die TEX4HT-Dokumentation an sich ist nicht besonders üppig. Eine komplette Aufli-
stung der Optionen, ausgegeben in die Logdatei, erhalten Sie, wenn Sie einen Aufruf

htlatex.bat myfile.tex "html,2,info"

in der Kommandozeile auf einer beliebigen LATEX-Datei absetzen. Unbedingt htlatex.bat
aufrufen, nicht einfach htlatex, da sonst ein MikTeX-Programm gestartet wird.

Da ich so klares XHTML und so kleine Dateien wie möglich erhalten möchte, verwende
ich den meist den Aufruf

21TeX4ht kann nur Pfadangaben ohne Leerzeichen verarbeiten
22Info-Zip. http://www.info-zip.org.
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htlatex.bat myfile.tex "xhtml,2,fn-in,NoFonts,fonts,graphics-,sections+,C
next"

für die Umwandlung. Das erzeugt XHTML, eigene Dateien für zwei Gliederungsebenen,
keine speziellen Schriftenanweisungen, aber prinzipielle Formatierungen, nichtskalierte
Grafiken und hilfreiche Hyperlinks. Wer eine originalgetreuere Wiedergabe der Schriften
haben möchte, läßt die Option NoFonts weg, was natürlich zu ein wenig größeren Dateien
führt. Für eine monolithische Datei wird statt der 2 eine 0 angegeben.

Grafikumwandlung Alle Grafiken, die Sie in einem Dokument verwenden, müssen na-
türlich irgendwo herkommen. Generell rate ich davon ab, Diagramme oder Grafiken als
Bitmap zu erstellen, etwa mit Photoshop oder ähnlichen Programmen. Vielmehr empfe-
hel ich vektororientierte Programmen wie z. B. CorelDraw, OpenOffice.org Draw, Visio
oder ähnlichen. Fast alle Anwendungen wie Excel oder PowerPoint oder MATLAB ver-
arbeiten ihre Grafiken ebenfalls vektororientiert, und erzeugen deshalb mit Hilfe des Post-
script Druckertreibers hervorragende Postscriptdateien. Diese Postscriptdateien wandeln
Sie dann in EPS um23.

Die generierte Datei mit der Erweiterung .eps laden Sie in GSVIEW, um zu sehen, ob
z. B. noch die Bounding Box angepaßt werden muß. Um in GSVIEW die Bounding Box
anzeigen zu lassen, wählen Sie Menü Options→ Show Bounding Box.

Sollte die Bounding Box nicht stimmen, so kann mit dem Befehl File→ PS to EPS entwe-
der automatisch oder manuell die Bounding Box festlegen lassen und die Ausgabe in eine
neue Datei speichern. Automatisch können Sie dabei wählen, wenn die komplette Grafik
verwendet werden soll. Manuell legen Sie die Bounding Box nur dann fest, wenn uner-
wünschte Kopf- oder Fußzeilen abgeschnitten werden sollen.

Unbedingt beachten: Erstellen Sie Postscript oder DVI, müssen Bilder im (Encapsulated)
Postscript-Format (EPS) vorliegen, wohingegen beim Verwenden von PDFLATEX hingegen
nur Grafiken verarbeitet werden, die in PDF, JPEG oder PNG vorliegen. Zwar können
Sie sowohl dem einen als auch dem anderen LATEX-Prozessor alle Bildtypen beibringen,
müssen dazu aber spezielle Optionen verwenden, die dann vielleicht nicht portierbar auf
andere Systeme sind. Soll also beides – DVI und PDF – erzeugt werden, müssen die Bilder
meistens auch in zwei Formaten vorliegen.

Wollen Sie mittels PDFLATEX aus Ihren Dokumenten das PDF erzeugen, so müssen die
EPS-Dateien also nach PDF umgewandelt werden. Dazu gibt es den Befehl epstopdf, der
etwa so aussieht:

epstopdf file1.eps

Bitmapdateien wie JPEG oder PNG werden von PDFLATEX direkt gelesen. Nur für den
normalen LATEX-Aufruf müssen sie mit bmeps nach EPS umgewandelt werden .

Grafiken aus METAPOST, einer LATEX-nahen Grafiksprache, können ohne Umwandlung
eingebunden werden.

23siehe dazu auch Schlosser, Joachim: EPS Writer für Windows. http://schlosser.info/epswriter
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5 Wenn etwas nicht funktioniert

Sollte irgendetwas nicht funktionieren, oder sich offensichtlich seltsam verhalten, ist das
kein Beinbruch. Häufig liegt es an vergessenen Umgebungsvariablen. So sollte zunächst
überprüft werden ob alle von dieser Anleitung geforderten Umgebungsvariablen entspre-
chend gesetzt wurden. Fehlt eine, oder ihr Inhalt ist falsch, dann ist es möglich, daß eine
danach durchgeführte Installation – vor allem von PREVIEW-LATEX – fehlschlug. Also noch-
mal. Außerdem eine beliebte Fehlerquelle: Dateien am falschen Ort. Einfach nochmal nach
Anleitung kontrollieren und ggf. korrigieren.

Gegebenenfalls sollten Sie dann auch einen Blick in die Installationsanweisung des je-
weiligen Pakets werfen, ob dort noch weitere Hinweise zu finden sind. Denn natürlich
auch nicht auszuschließen ist, daß meine Anleitung einen Fehler enthält. Wenn eigentlich
alles stimmen müßte, am besten unter Angabe der Versionsnummer bei mir nachfragen.
Vielleicht habe ich eine Annahme getroffen, die nicht allgemein statthaft ist, oder eine neue
Version eines Pakets arbeitet anders und dieser Text ist veraltet.

6 Ausblick

Bei all den Möglichkeiten, die einem die Vielzahl der Pakete für LATEX bieten, gilt immer:
nicht in den Spielereien verlieren. Einfache Layouts und Strukturen wählen, insbesondere,
wenn das Dokument auch in HTML publiziert werden soll.

Bei weitem nicht alle Feinheiten der Dokumentenumgebung können in diesem Umfang
erörtert werden. Mit Hilfe dieses Artikels jedoch sollte es jedem einigermaßen mit Win-
dows vertrauten Benutzer möglich sein, relativ rasch mit dem Schreiben und Setzen von
Texten beginnen zu können. Ich selbst habe erst 2002 LATEX für mich entdeckt und möch-
te es nicht mehr missen. Jeder wird, wenn er/sie sich erst einmal darauf einläßt, von den
Vorteilen begeistert sein, die es bringt, Texte in hoher Qualität setzen zu lassen anstatt sich
über die Unzulänglichkeiten eines Wortprozessors zu ärgern.

Wenn dieses Dokument dazu beiträgt, die Scheu vor der Einrichtung und Nutzung eines
solchen Systems ein wenig zu lindern und somit die Hemmschwelle zum Einstieg in LATEX
herabzusetzen vermag, dann hat es seinen Zweck erfüllt.
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